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Abstract

These Application Notes describe the procedures for configuring Session Initiation Protocol
(SIP) Trunking between service provider MTS Allstream switch and Avaya IP Office 9.1

MTS Allstream SIP Trunk Service (MTS Allstream) provides PSTN access via a SIP trunk
between the enterprise and the MTS Allstream network as an alternative to legacy analog or
digital trunks. This approach generally results in lower cost for the enterprise.

MTS Allstream is a member of the Avaya DevConnect Service Provider program. Information
in these Application Notes has been obtained through DevConnect compliance testing and
additional technical discussions. Testing was conducted via the DevConnect Program at the
Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between MTS Allstream and Avaya IP Office solution. In the sample configuration, the
Avaya IP Office solution consists of an Avaya IP Office 500v2 Release 9.1, Avaya embedded
Voicemail, Avaya Communicator for Windows (SIP mode), Avaya H.323, Avaya SIP, digital and
analog endpoints.

The MTS Allstream referenced within these Application Notes is designed for business customers.
The service enables local and long distance PSTN calling via standards-based SIP trunks as an
alternative to legacy analog or digital trunks, without the need for additional TDM enterprise
gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office
connecting to MTS Allstream.

This configuration (shown in Figure 1) was used to exercise the features and functionality tests
listed in Section 2.1. Note: NAT devices added between Avaya IP Office and the MTS Allstream
network should be transparent to the SIP signaling.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to MTS Allstream. To verify SIP
trunking interoperability, the following features and functionality were exercised during the
interoperability compliance test:

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

e Inbound and outbound PSTN calls from/to the Avaya Communicator for Windows (SIP
mode).

e Inbound and outbound long hold time call stability.

e Various call types including: local, long distance, international call, outbound toll-free,
operator assisted call, 411 and 911 services.

e Codec G.729A and G.711MU.

e Caller number/ID presentation.
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Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

FAX using T.38 and G.711 pass-through.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

2.2. Test Results

Interoperability testing of MTS Allstream was completed with successful results for all test cases
with the exception of the limitation described below.

Blind Call Transfer to PSTN using Avaya 1140E SIP phone does not complete until
transferee picks up the call — Call scenario is when PSTN phone calls to Avaya 1140E SIP
phone, Avaya 1140E SIP phone answers the call and performs blind transfer to another
PSTN endpoint. The expected behavior of Avaya 1140E SIP phone is after transfer, the
phone should display “transfer completed”. But in this case, user presses “transfer” button,
answers question of “Consultative transfer with party ?” with “No”, which implies the blind
transfer, as the transferee PSTN phone is ringing, the Avaya 1140E SIP phone should be
released and display “transfer successfully”. Instead, the Avaya 1140E SIP phone still
displays “transferring” and not released until the transferee PSTN phone answers the call.
The work around is to hang up the Avaya 1140E SIP phone. This is very minor known
limitation on Avaya 1140E SIP phone. There is no user impact. Transfer is still completed
with two-way audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes visit:
http://support.avaya.com

For technical support on the MTS Allstream SIP Trunk Service, please contact customer service at
855-299-7050 or visit: http://www.allstream.com/support.

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to MTS Allstream through the public IP network. For confidentiality and privacy
purposes, actual public IP addresses used in this testing have been masked out and replaced with
fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office 500v2 with the MOD DGTL STA16 expansion
module which provides connections for 16 digital stations to the PSTN, and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(\Voice Compression Module) for supporting VVolP codecs. The voicemail service is embedded on
Avaya IP Office. The LAN2 port of Avaya IP Office is connected to the public IP network.
Endpoints include Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya 1100 Series IP
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Telephone (with SIP firmware), Avaya 1408D Digital Telephones, Avaya Analog Telephone, and
Avaya Communicator for Windows. A separate Windows XP PC runs Avaya IP Office Manager to
configure and administer Avaya IP Office.

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user’s
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with MTS Allstream SIP Trunk Service

For the purposes of the compliance test, Avaya IP Office users dialed a short code of 9 + N digits to
send digits across the SIP trunk to MTS Allstream. The short code of 9 was stripped off by Avaya IP
Office but the remaining N digits were sent unaltered to MTS Allstream. For calls within the North
American Numbering Plan (NANP), the user would dial 11 (1 + 10) digits. Thus for these NANP
calls, Avaya IP Office would send 11 digits in the Request URI and the To field of an outbound SIP
INVITE message. It was configured to send 10 digits in the From field. For inbound calls, MTS
Allstream sent 10 digits in the Request URI and the To field of inbound SIP INVITE messages.
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In an actual customer configuration, the enterprise site may also include additional network
components between the service provider and the Avaya IP Office such as a session border
controller or data firewall. A complete discussion of the configuration of these devices is beyond the
scope of these Application Notes. However, it should be noted that SIP and RTP traffic between the
service provider and the Avaya IP Office must be allowed to pass through these devices.

4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment Release
Avaya IP Office 500v2 9.1.0.0 Build437
Avaya IP Office DIG DCP*16 V2 9.1.0.0 Build437
Avaya IP Office Ext Card Phone 8 9.1.0.0 Build437
Avaya IP Office Manager 9.1.0.0 Build437
Avaya 1140E SIP 04.04.18.00
Avaya IP 9640G S3.2
Avaya IP 9630 S3.2
Avaya Communicator for Windows (SIP) 2.0.3.30
Avaya Digital Telephone (1408D) N/A
Avaya Symphony 2000 Analog Telephone N/A
HP Officejet 4500 (fax) N/A

MTS Allstream Components

Equipment Release
Genband S3 SBC 7.1.15.2
Genband CS2K Hybrid SoftSwitch CVML17

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone IP
Office 500 V2 and also when deployed with all configurations of IP Office Server Edition without
T.38 Fax Service.
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5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to MTS Allstream.
Avaya IP Office is configured through the Avaya IP Office Manager PC application. From a PC
running the Avaya IP Office Manager application, select Start - Programs - IP Office >
Manager to launch the application. Navigate to File > Open Configuration, select the proper
Avaya IP Office system from the pop-up window, and log in with the appropriate credentials. A
management window will appear similar to the one shown in the next section. The appearance of the
IP Office Manager can be customized using the View menu. In the screens presented in this section,
the View menu was configured to show the Navigation pane on the left side, the Group pane in the
center, and the Details pane on the right side. These panes will be referenced throughout the Avaya
IP Office configuration. Proper licensing as well as standard feature configurations that are not
directly related to the interface with the service provider (such as the LAN interface to the enterprise
site and IP Office Softphone support) is assumed to be already in place.

5.1. LAN2 Settings

In the sample configuration, the IPOffice_1 was used as the system name and the LAN2 port was
used to connect to MTS Allstream. To access the LAN2 settings, first navigate to IPOffice_1 >
System (1) in the Navigation and Group Panes and then navigate to the LAN2-> LAN Settings tab
in the Details Pane. Set the IP Address field to the IP address assigned to the Avaya IP Office LAN
port. Set the IP Mask field to the mask used on the public network. All other parameters should be
set according to customer requirements. Click OK to submit the change.

=
System ; 7 1POffice_1" v
Systern - LAML ANE DN | Yocumel | Telepheny | Dvestery Sensve | Syvtem Everty | SMTP | SMOR  Tomwmang | VOM | Codecs | ValP Secasrty | Comtas) Covter

LAN Settings| yulP Netwoe Topdogy

P Addrenz bl ) 2

ki\"‘?f_ll@ )agreTa™s o

The VolIP tab as shown in the screenshot below was configured with following settings.

e Check the H323 Gatekeeper Enable to allow Avaya IP Telephones/Softphones using the
H.323 protocol to register.

e Check the SIP Trunks Enable to enable the configuration of SIP Trunk connecting to MTS
Allstream.

e Check the SIP Registrar Enable to allow Avaya IP Telephones/Softphones to register using
the SIP protocol.

e Input Domain Name as 10.10.98.14.

e The Layer 4 Protocol use UDP with port 5060 and TCP with port 5060.
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e Verify the RTP Port Number Range settings for a specific range for the RTP traffic. The
Port Range (Minimum) and Port Range (Maximum) values were kept as default.

e Check Enable RTCP Monitoring on Port 5005.

e Verify the DiffServ Settings were kept as default for the Differentiated Services Code Point
(DSCP) parameters in the IP packet headers to support Quality of Services policies for both
signaling and media, the DSCP field is the value used for media and the SIG DSCP is the
value used for signaling.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

|| 7 IPOffice_1* e - v

LAN Settings_i Network Topology- }

I@ H323 Gatekeeper Enable]
[7] Auto-create Extn Auto-create User [7] H323 Remote Extn Enable

| system [ LANL |[LAN2] |DNs | Voicemail | Telephony | Directory Services | System Events [ sMTP [ SMDR | Twinning | veM [ Codecs | VoIP security | Contact Center|

-

+ 11720

[¥] SIP Trunks Enable

[¥] SIP Registrar Enable

[7] Auto-create Extn/User [7] SIP Remote Extn Enable
Domain Name 1010.98.14 —I
[¥] uop UDP Port 5060 s Remote UDP Port (5060 2
Layer 4 Protocol @l Tcp TCP Port 5060 - Remote TCP Port 5060 = =
[ TLs TLS Port |5061 2 Remote TLS Port 5061 S
Challenge Expiry Time (secs) 10
RTP
Port Number Range
Minimum 9152 2 Maximum 53246 1=
Port Number Range (NAT)
Minimum 49152 . Maximum 53246

[¥] Enable RTCP Monitoring on Port 5005 |

RTCP collector IP address for phones 0 0 0 0
Keepalives
Scope [ Disabled - 30
Enabled
DiffServ Settings

B8 +| DSCP(Hex) B8 % Video DSCP(Hex) |FC | DSCP Mask (Hex) 88 + SIG DSCP (Hex)

46 =| pscp 46 | Video DSCP 63 > DSCP Mask 34 + SIG DSCP

I oK H Cancel H Help
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On the Network Topology tab in the Details Pane, configure the following parameters:

o Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set the Binding Refresh Time (seconds) to 60. This value is used as one input to determine
the frequency at which Avaya IP Office will send SIP OPTIONS messages to the service
provider.

e Set Public IP Address to the IP address of the Avaya IP Office LAN2 port.

e Set Public Port for UDP as 5060 and TCP as 5060.

e All other parameters should be set according to customer requirements.

e Click OK to submit the changes.

i iz IPOffice_1* = v

”System | LANl [[Lan2 DNS l Voicemail i ;l’elepﬁony [ Dingectory Services | System E;/ents ] SMTP [ éMDR l Twinniﬁg I VCM I Codécs l VOIP Securify Contact Centeri

|| LAN Settings [ Vol | [Network Topology] |

Network Topology Discovery
STUN Server Address 192.168.10.13 STUN Port 3478
Firewall/NAT Type Open Internet v |
‘ Binding Refresh Time (seconds) 60 v
Public IP Address 10 10 9 14 ‘ Run STUN Cancel
Public Port
uUDP 5060
TCP 5060
TLS 5061

|| Run STUN on startup

I oK H Cancel H Help ‘

In the compliance test, the LANL1 interface was used to connect the Avaya IP Office to the enterprise
site IP network. The LANL1 interface configuration is not directly relevant to the interface with MTS
Allstream, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
Telephony = Telephony tab in the Details Pane. Choose the Companding Law typical for the
enterprise location. For North America, U-Law is used. Uncheck the Inhibit Off-Switch
Forward/Transfer box to allow call forwarding and call transfers to the PSTN via the service
provider across the SIP trunk. Set Hold Timeout (secs) to 1200. Click OK to submit the change.

B IPOffice_1*

& -

v

‘ System | LANL I LAN2 ] DNS ] Voicemaili Telephony| ‘ Directory Services I System Events I SMTP | SMDR | Twinning I VCM I Codecs I VolP Security | Contact Center

Default Name Priority
Media Connection Preservation Disabled X

Login Code Complexity

[] Enforcement

Complexity

Telephony] | Park & Page | Tones & Music| Ring Tones [ SM | Call Log | TUI
Analogue Extensions Companding Law
Switch Line
Default Outside Call Sequence 1Normal v]
Default Inside Call Sequence [Ring Typel V] M_'
Default Ring Back Sequence {Ring Type2 'l
i i X = ) A-Law ) A-Law Line
Restrict Analogue Extension Ringer Voltage i~
-
Dial Delay Time (secs) 4 055 Status
[¥] Auto Hold
Dial Delay Count 0 PR
L Dial By Name
Default No Answer Time (secs) 15
[¥] Show Account Code
Hold Timeout (secs) 1200 =
[7] Inhibit Off-Switch Forward/Transfer
Park Timeout (secs) 300
[7] Restrict Network Interconnect
Ring Delay (secs) 5
- Include location specific information
Call Priority Promotion Time (secs) |Disabled < <o
[ Drop External Only Impromptu Conference
Default Currency usb v

[7] Visually Differentiate External Call

["] Unsupervised Analog Trunk Disconnect Handling
& High Quality Conferencing

[¥] Digital/Analogue Auto Create User

[”] Directory Overrides Barring

m

[ 0K l l Cancel ] [ Help
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5.3. System Codec Settings

Navigate to IPOffice_1 - System (1) in the Navigation and Group Panes and then navigate to the
Codecs tab in the Details Pane. Choose the RFC2833 Default Payload as IP Office default of 101.
Select codecs G.711 ULAW 64K, and G.729(a) 8K CS-ACELP that MTS Allstream supports.
Click OK to submit the change.

i= IPOffice_1 o v
i System I LAN1 I LAN2 [ DNS 1 Voicemail ] Telephony l Directory Services I System Events l SMTP I SMDR | Twinning I VCM | [Codecs !VoIP Security | Contact Centeri
‘RFC2833 Default Payload 101 > ‘
Available Codecs Default Codec Selection
Unused Selected
[@] G711 ULAW 621 6.723.1 6K3 MP-MLQ 3> G.711 ULAW 64K
V] G711 ALAW 64} G.711 ALAW 64K G.729(a) 8K CS-ACELP
| G.722 64K

[V 6.729(a) 8K CS-ACELP
[V] 67231 6K3 MP-MLQ

| OK H Cancel H Help
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5.4. Twinning Calling Party Settings

When using twinning, the calling party number displayed on the twinned phone is controlled by two
parameters. These parameters only affect twinning and do not impact the messaging or operation of
other redirected calls such as forwarded calls. The first parameter is the Send original calling party
information for Mobile Twinning box on the Twinning tab, as shown below. The second
parameter is the Send Caller 1D parameter on the SIP Line form (shown in Section 5.5.2).

If Send original calling party information for Mobile Twinning on the Twinning tab is checked,
the setting of the second parameter is ignored and Avaya IP Office will send the following in the SIP
From Header:
e On calls from an internal extension to a twinned phone, Avaya IP Office will send the calling
party number of the originating extension.
e On calls from the PSTN to a twinned phone, Avaya IP Office will send the calling party
number of the host phone associated with the twinned destination (instead of the number of
the originating caller).

If this option is unchecked, the value sent in the SIP From header is determined by the setting of the
second parameter mentioned above.

e For the compliance test, the Send original calling party information for Mobile Twinning
box in the IPOffice_1 = System (1) - Twinning tab was unchecked. The value sent in the
SIP From header is determined by the setting of the Send Caller 1D parameter on the SIP
Line form.

= IPOffice_1 i v

}”S;stem I LAN1 I LANZ IDNS I VVc;ircemarilr %élep}hony i bi;edory 7Serr\.rlirces IVSVystemrErvents iSMT;’ |SMDR VCM IVCoare:s l \710717P”Secu}irty iréontact VCVenter‘;

| Send original calling party information for Mobile Twinning I

Calling party information for
Mobile Twinning
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5.5. Administer SIP Line

A SIP line is needed to establish the SIP connection between Avaya IP Office and MTS Allstream
SIP Trunk service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.5.1 to create the SIP Line from the
template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.5.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.
e SIP Advanced Engineering.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New = SIP Line. Then, follow the steps outlined in Section 5.5.2.
For the compliance test, SIP Line 17 was used as trunks for incoming and outgoing calls.
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5.5.1. Create SIP Line from Template.
1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to AF_MTSAIlIstream_SIPTrunk.xml (for SIP Line 17). The file name is
important in locating the proper template file in Step 5.

2. Verify that template options are enabled in IP Office Manager. In IP Office Manager,
navigate to File 2 Preferences. In the IP Office Manager Preferences window that appears,
select the Visual Preferences tab. Verify that the box is checked next to Enable Template
Options. Click OK to submit the changes.

™ IP Office Manager Preferences l 2 I&J
i Preferences I Directories ] Discovery J [Vi5U3| Preferencesl j Security I Validation‘
! Icon Size ‘Small vl

7] Multiline Tabs

l (/| Enable Template Optionsl

[¥| Enable Template Creation

(1) ‘ oK l ! Cancel I l Help

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager. This action will copy the template file into the IP Office
template directory and make the template available in the IP Office Manager pull-down
menus in Step 5. The default template location is C:\Program Files\Avaya\lP
Office\Manager\Templates.

' Asaya P Ofice Manoger IPOMCe T 75 1OAIT] drvenistmondminsmaor] =
Fie B Yeew Tocts|| Hep
» |
‘ | E sPlsenen CEEICIAR
Expart :"" SubTrpe: | oo Lane Trnsgpon| 5 LI VoiP | 3% Ter 9P Credontive| SP Advinced | Engloesing
SO Sevsce Uses Managasent :
By an Hewd Valdoion
MSH Cosfigusntion |
Impert Tamrpristen in Manages
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In the pop-up window (not shown) that appears, select the directory where the template file
was copied in Step 1. After the import is complete, a final import status pop-up window
below will appear stating success (or failure). Then click OK to continue. If preferred, this
step may be skipped if the template file is copied directly to the IP Office template directory.

F

Y
Template Provisioning &J

. \ Successfully imported templates to IP Office Manager from
L CA\MSTAllstream - IPO\Template

oK |

4. To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then
navigate to New SIP Trunk from Template.

1P Offices Line |E SIP Line - Line 20 o-3 X v -
R poowm Line Namber  Line Type e b Type || o e Tramment| 59 WS VP | 738 70 TR C T pdvanced Eng -
Opesatar (3) -1 PRE 24 (Wnvessall T3
ey New
() [ Phew 20 Trunk feoem Tempilets |
Cq
@ ia
§
& G
=
D
o BN
v
9w
-~ D |
L
[ B |
o A e

5. In the subsequent Template Type Selection pop-up window, check Display All and select
AF_MTSAIlIstream_SIPTrunk from the Service Provider pull-down menu as shown
below. These values correspond to parts of the file name
(AF_MTSAIlIstream_SIPTrunk.xml) created in Step 1. Click Create new SIP Trunk to
finish creating the trunk.

" Template Type Selection I = ‘%I
Locale United States (US English
Service Provider | AF_MTSAllstream_SIP Trunk v’ [¥] Display Al
[ Create new SIP Trunk ] l Cancel ]

6. Once the SIP Line is created, verify the configuration of the SIP Line with the configuration
shown in Section 5.5.2.
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5.5.2. Create SIP Line Manually
To create a SIP line, begin by navigating to Line in the left Navigation Pane, then right-click in the

Group Pane and select New - SIP Line (not shown).
On the SIP Line tab in the Details Pane, configure the parameters as shown below:

Set ITSP Domain Name to the IP address of Avaya IP Office LANZ2 port.

Check the In Service and Check OOS boxes.

Set URI Type to SIP.

For Session Timers, set Refresh Method to Reinvite with Timer (seconds): 1200.

For Forwarding and Twinning, set Send Caller ID to None.

For Redirect and Transfer, set Incoming Supervised REFER and Outgoing Supervised
REFER to Never. Note: MTS Allstream did not support the REFER for compliance testing.
Default values may be used for all other parameters.

e Click OK to commit then press Ctrl + S to save.

POMces | Une Ey SIP Line - Line 17° o-d X v
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On the Transport tab in the Details Pane, configure the parameters as shown below:

e The ITSP Proxy Address was set to the IP Address of MTS Allstream signaling server
192.168.2.12 as shown in Figure 1.

¢ Inthe Network Configuration area, UDP was selected as the Layer 4 Protocol and the Send
Port was set to 5060 which is the port number provided by MTS Allstream.

e The Use Network Topology Info parameter was set to LAN 2. This associates the SIP Line 17
with the parameters in the System (1) > LAN2 - Network Topology tab.

e The Calls Route via Registrar was unchecked. In this certification testing, MTS Allstream did
not support the dynamic Registration on the SIP Trunk.

e Other parameters retain default values.

e Click OK to commit then press Ctrl + S to save.

i= SIP Line - Line 17 k- X v<|s

|SIP Line|Transport] s1p URI[VolP [ 738 Fax|SIP Credentials|SIP Advanced| Engineering

lrrsp Proxy Address 192168212 |

Network Configuration

Layer 4 Protocol IUDP v | Send Port 5060
Use Network Topolegy Info ILAN 2 v . : 5060
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar [ ‘

Separate Registrar

’ 0K H Cancel H Help
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A SIP URI entry must be created to match each incoming number that Avaya IP Office will accept
on this line. Select the SIP URI tab; click the Add button and the New Channel area will appear at
the bottom of the pane (not shown). To edit an existing entry, click an entry in the list at the top, and
click Edit... button. In the example screen below, a previously configured entry is edited. For the
compliance test, a single SIP URI entry was created that matched any DID number assigned to an
Avaya IP Office user. The entry was created with the parameters shown below:

e Set Local URI, Contact, Display Name, and PAI to Use Internal Data. This setting allows
calls on this line whose SIP URI matches the number set in the SIP tab of any User as shown
in Section 5.7.

e Set Registration to 0: <None>as MTS Allstream does not require registration.

e Associate this line with an incoming line group in the Incoming Group field and an
outgoing line group in the Outgoing Group field. This line group number will be used in
defining incoming and outgoing call routes for this line. For the compliance test, a new line
group 17 was defined that only contains this line (line 17).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Click OK to submit the changes.

E SIP Line - Line 17
B Line]Transpo¢§|MiVolp | 738 Fax|SIP Credentials|SIP Advanced | Engineering
Channel Groups Via Local URI Contact Display Name PAI Credential Max Calls Add...
Remove
Edit...
Edit Channel
Via 10.10.98.14 K
Local URI Use Internal Data - Cancel
Contact Use Internal Data -
Display Name Use Internal Data v
PAI -
Registration [0: <None> v
Incoming Group 17
Outgoing Group 17
Max Calls per Channel 20 =
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Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:

e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified. The G.711 ULAW 64K, and
G.729(a) 8K CS —ACELP codecs are selected. Avaya IP Office supports these codecs,
which are sent by the MTS Allstream in the Session Description Protocol (SDP) offer, in that
order.

e Uncheck the VoIP Silence Suppression box.

e Check the Re-invite Supported box.

e Set Fax Transport Support to T38 Fallback from the pull-down menu. MTS Allstream
supports both Fax T.38 and Fax G.711 pass-through modes.

e Set the DTMF Support to RFC2833 from the pull-down menu. This directs Avaya IP
Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Default values may be used for all other parameters.

e Click OK to submit the changes.

7 SIP Line - Line 17 k- X|v<]|>
|SIP Line | Transport | SiP URI \T38 Fax|SIP Credentials|SIP Advanced|Engineering
I\il VolIP Silence Suppressionl
|¥| Re-invite Supported
Codec Selection [Custom 'J [7] Codec Lockdown
Unused Selected Allow Direct Media Path
6.72316K3 MP-MLQ G.711 ULAW 64K o Al
orce e edia wit NEs
G.711 ALAW 64K G.729(a) 8K CS-ACELP 0Orce girect medaia with phone
[7] PRACK/100rel Supported
== [7] G.711 Fax ECAN
<L ‘
Fax Transport Support \T38 Fallback VI
DTMF Support |RFC2833 ~|
Media Security [Disabled >3
I OK I 1 Cancel ] [ Help
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5.6. Short Code

Define a short code to route outbound traffic on the SIP line to MTS Allstream. To create a short
code, select Short Code in the left Navigation Pane, then right-click in the Group Pane and select
New (Not shown). On the Short Code tab in the Details Pane, configure the parameters for the new
short code to be created. The screen below shows the details of the previously administered “9N;”
short code used in the test configuration.

In the Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 9N;, this short code will be invoked when the user dials 9 followed by
any number.

Set Feature to Dial. This is the action that the short code will perform.

Set Telephone Number to N”@192.168.2.12”. This field is used to construct the Request
URI and To headers in the outgoing SIP INVITE message. The value N represents the
number dialed by the user. The host part following the “@” is the IP address of MTS
Allstream signaling server.

Set the Line Group ID to the Outgoing Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2. This short code will use this line group when placing the outbound
call.

Set the Locale to United States (US English).

Default values may be used for all other parameters.

Click OK to submit the changes.

P Offices | Short Code £ 9N;: Dial* el X o
R poOw Code Tebaghane Numbaer - o™ 3
[} e | LN [
MUY eno 910 0 o
oY BNENED FNE Senvice Fesare o
P Numbe 16821
l§ i 1D ]
;: Jreted States Eng’
x4 ¥ Con
en i o 3
o
o ..” Lanewt Hep
% et B
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The feature of incoming calls from mobility extension to idle-appearance FNE (Feature Name
Extension) is hosted by Avaya IP Office. The Short Code FNEOO was configured with following
parameters:

e For Code field, enter FNE feature code as FNEOQO for dial tone.

e Set Feature to FNE Service.

e Set Telephone Number to 00.

e SetLine Group ID to 0.
Set the Locale to United States (US English).
Default values may be used for other parameters.
Click OK to submit the changes.

Pofices || Short Code I=  FNEOC;FNE Service [or-8 x v -

Telaghzne Number  Famare . Shert Code
| LTEN N Dis
oy T AT p Cede P

Ureted States (\5 Enghan| 2.

S 16or9Ta™) : 2

oK Cancel Help
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5.7. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.5. To configure these settings, first select User in the left Navigation Pane, then
select the name of the user to be modified in the center Group Pane. In the example below, the name
of the user is 1257. Select the SIP tab in the Details Pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line. The example below
shows the settings for user 1257. The SIP Name and Contact are set to one of the DID numbers
assigned to the enterprise provided by MTS Allstream. The SIP Display Name (Alias) parameter
can optionally be configured with a descriptive name. If all calls involving this user and a SIP Line
should be considered private, then the Anonymous box may be checked to withhold the user’s
information from the network.

User E 1267: 1287 oA X ¢

Foowsrdng  Dalls | Youe Recording | Buon Pragiammng | Menu Programmng |- Moty | Gioup Menberthg | Armoencements | % | Pagomal 1

s 1258 SP Nare
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One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User 1257. The Mobility Features and Mobile Twinning boxes
are checked. The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 91613XXX5205. Check Mobile Call Control to allow
incoming calls from mobility extension to access FNEOO (see Section 5.6). Other options can be set
according to customer requirements.

b 1257: 1257* -9 | X[ v |<]|>

Forwarding l Dial In I Voice Recording | Button Programming l Menu Programming | [Mobility [ Group Membership | Announcements I SIP [ Personal [+ [+

[7] Internal Twinning

<None>

Twin Bridge Appearances
Twin Coverage Appearances

Twin Line Appearances

[¥] Mobili

Twinngd quile Number 91612)00(5205
(including dial access code)

Twinning Time Profile <None>

Mobile Dial Delay (secs) 2

-~

Mobile Answer Guard (secs) 0

[T] Hunt group calls eligible for mobile twinning
[”] Forwarded calls eligible for mobile twinning
[7] Twin When Logged Out

[7] one-X Mobile Client

[[Z] Mobile Call Control
[¥] Mobile Callback
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5.8. Incoming Call Route

An Incoming Call Route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by service provider. To create an
incoming call route, select Incoming Call Route in the left Navigation Pane, then right-click in the
center Group Pane and select New (Not shown). On the Standard tab of the Details Pane, enter the
parameters as shown below:

e Set the Bearer Capability to Any Voice.

e Setthe Line Group ID to the Incoming Group 17 defined on the SIP URI tab on the SIP
Line in Section 5.5.2.

e Set the Incoming Number to the incoming DID number on which this route should match.

e Default values can be used for all other fields.

IP Offices | incoming Call Routs |E 17 B4TXXX1267 N

e Grpup 0 Incemang Mumber  Detnation Gandard

Vorce Zecorbg | Destnaton

Searwr Capabiny Ay Voxe -

Linve Groug [T

Locale Unatad States (US bngiehy -

1-lew -

l."llll?- iﬁor Q!u"?

On the Destination tab, select the destination extension from the pull-down menu of the Destination
field. In this example, incoming calls to 647XXX1257 on line 17 are routed to extension 1257.

~ IPOffices = 17 BATXXX1267 o4 X v
R 300TF & Line G Stangard | Youre Becoring Dethinasons
- ou e Dentinabion Faltsack Ecermion
g;‘: “ » Detaut Vatuw )7“.;7..'.' 7'i
1.7 260
< -1 FNEXD
i
]
L]
@
o RA
2
ww
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For testing purpose, the incoming calls to DID number 647XXX1264 were configured to access
FNEOQO. The Destination was appropriately defined as FNEOO as below screenshot:

IP Offices | incoming Call Route B 17 BATXXX1264 pred X o

we bisup D Incomng Number  Destnstion Staesdard  Vorce Aecontbry | (Destnrion

Tmebrotee Demtinat o0 Foltack ltenpon

3 Dtk Ve | $3T0 . 4 ‘

RAS I "
Incoming Call Route (5)]
WAN Pos

For testing purpose, the incoming calls to DID number 647XXX1264 were also configured to access
VoiceMail. The Destination was appropriately defined as VVoiceMail as below screenshot:

1P Offices | incoming Call Routs |E 17 647XXX1264 pred X v
Line brsup D Incemng Number  Destnstion Saestard  Viece Tecorbig Destnytan |
g:: Tmebrotes Destiruty on sltack Ltenpon
e 2 > Dtk Vatue || Vomatdas - =
S
~

L 0!(«'&} 24 . =

Incoming Cak foute |5]
WAN Do 12

5.9. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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6. MTS Allstream SIP Trunk Configuration

MTS Allstream is responsible for the configuration of MTS Allstream SIP Trunk Service. The
customer must provide the IP address used to reach the Avaya IP Office at the enterprise. MTS
Allstream will provide the customer the necessary information to configure the SIP connection
between Avaya IP Office and MTS Allstream. The provided information from MTS Allstream
includes:

e [P address and port number used for signaling or media through any security.

e DID numbers.

e MTS Allstream SIP Trunk Specification.
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7. Verification Steps
The following steps may be used to verify the configuration:

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start - Programs - IP Office - System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State for each channel
(The below screen shot showed 2 active calls at present time).

15 Avayn 7P Offce Systen Sates - POMce 1 (10,1083 141 - IPS00 VZ 3100 bold &37 [

AVAYA IP Office System Status
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=
L ” OO Eamn 1260, 1289 Cormmetd o003 el 17 5P 10058 Comrested 2303 FRIIOOENE | RID Aley
:".‘” < 000033 ey PSP DR Cowacied 00-00-353 1R 1000CI200@ 192 ‘B 1257, 1257 Corracies 00:00:22 RTP Rty
-

»

n

n

n

S Avayn 7 Office Systewn States - POMKe L (I0.IN36.14 - 500 ¥2 3100 budild 437 i |

IP Office System Status

SIP Trunk Sumimary
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Poer Doman Nawes 101038 14

Reaviez Axywes 192 168212
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Use the Avaya IP Office System Status application to verify that no alarms are active on the
SIP line. Launch the application from Start = Programs - IP Office - System Status on
the PC where Avaya IP Office Manager was installed. Select Alarm - Trunks to verify that
no alarms are active on the SIP line.

[

L inds O

A Cad Gunbiy of S
8 becwrny (8

Lt
Live2
Liem:AT

1S Avays P Office Systen States - FOMCe 1 (I0IN3B1E - F300 V2 3100 bedld 437 [

AVAYA IP Office System Status

Sebect 4 b 10 duplay the alerss information

TN

Verify that a phone connected to the PSTN can successfully place a call to Avaya IP Office
with two-way audio.
Verify that a phone connected to Avaya IP Office can successfully place a call to the PSTN
with two-way audio.
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8. Conclusion

MTS Allstream passed compliance testing with a limitation noted in Section 2.2. These Application
Notes describe the procedures required to configure the SIP connection between Avaya IP Office
and the MTS Allstream as shown in Figure 1.

9. Additional References

[1] Avaya IP Office™ Platform Documentation Catalog Release 9.1, Document number 16-604278
Issue 2, December 2014

[2] Avaya IP Office™ Platform 9.1. Deploying Avaya IP Office™ Platform IP500 V2, Document
number 15-601042 Issue 30g, 27 January 2015

[3] Avaya IP Office™ Platform Embedded Voicemail User Guide (IP Office Mode), Document
number 15-604067 Issue 15a, 16 January 2015

Product documentation for Avaya products may be found at: http://support.avaya.com. Additional
Avaya IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php? XMLFILE=manuals.

XMI&TEMPLATE=pdf feed template.html

Product documentation for MTS Allstream SIP Trunk may be found at:
http://www.allstream.com/support.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 28 of 29
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSASIPIPO91


http://support.avaya.com/
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php?XMLFILE=manuals.xml&TEMPLATE=pdf_feed_template.html
http://marketingtools.avaya.com/knowledgebase/ipoffice/general/rss2html.php?XMLFILE=manuals.xml&TEMPLATE=pdf_feed_template.html
http://www.allstream.com/support

©2015 Avaya Inc. All Rights Reserved.

Avaya and the Avaya Logo are trademarks of Avaya Inc. All trademarks identified by ® and ™
are registered trademarks or trademarks, respectively, of Avaya Inc. All other trademarks are the
property of their respective owners. The information provided in these Application Notes is
subject to change without notice. The configurations, technical data, and recommendations
provided in these Application Notes are believed to be accurate and dependable, but are
presented without express or implied warranty. Users are responsible for their application of any
products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.

HV; Reviewed: Solution & Interoperability Test Lab Application Notes 29 of 29
SPOC 3/12/2015 ©2015 Avaya Inc. All Rights Reserved. MTSASIPIPO91



